iText Manual

% »
i Text follows iMac's concept...
Yes, it's Yummy too !!

The Comfortable Text Editor for Mac & PC

'1IText 3.1.7E « !

- ™
4 N\

Welcome to 'iText'! Pleased to meet you !!

Please allow me to describe it to you, but first please accept my
apologies for deficiencies in my English which is far from perfect.
I hope this will cause you laughter and not anger...

'i Text' is what your Mac's been waiting for !!

Our family of three programs is extremely popular in Japan. iText is a cute

little text editor with a colorful-design matching the iMac. It is free too !!

iTextPro is a delightful word processor, just right for most of your work.

Also, iText can be upgraded iTextPro by purchasing a key.

Finally, there is LightWayText a word processor with features for experts,

which can be used by beginners also. LightWayText is Shareware.

All three programs are completely compatible with each other.

There are also 'LightWayText French for Mac', 'LightWayText Italian for Mac',
and ‘LightWayText for Windows *, ‘iText for Windows ' which are completely
compatible with the Mac versions.

We have pleasure in releasing iText E, and hope many of you will try it !!

Please try iText out once and you will find it just what you want.
We look forward to working with you !!

Thanks for your kindness. - Yumiko Itoh (author of this manual)
et

1. About iText

iText is a cute text editor with simple word processing, fitting the charming iMac's colorful-
design. It has stability and lots of nice features selected from LightWayText .

iText will definitely let you recall 'the Macintosh mind of the early days' - The original Mac's
concept. iText will soon become your good friend, because it is especially easy to use !
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Editing operations are intuitive. There are many ways to change the appearance of your document;
besides styles, there are decoration lines, the ability to change all paragraph indents or margins,
and to paste in PICT images. Also, you can work with big text documents of even more than 32
kbytes at very high speed. iText 3.1.1 onwards also supports importing and exporting
Rich Text Format files (RTF). iText-X fully complies with Mac OS X 10.5 (Leopard).

You will find that iText is widely used, from programming to the writing of various documents,
in any language not only English and Japanese. Please use iText freely !!

- iText is aiming to be the Nol-freeware program, loved around the world !
We believe you Westerners also find iText useful!

We are improving iText all the time, using your suggestions...

LightWayText andiText are available for both Macs & PC.
In addition, they are compatible with each other's documents.
If you often share documents between a Mac and a PC,
put iText in both for convenience !

Please see the information on LightWayText-Family
in the last chapter of this manual.

T he latest information about

‘LightWayText for Windows' and 'iText for Windows' are available online at:

- LightwayText for Windows ;
http:/members.aol.com/LightWayText/L WTWin/pad_file.htm

- iText for Windows ;
http://members.aol.com/iText/iTextWin/pad_file.htm

XXX EAIE S EA IS EAIE S EAIE S XXX EAIE S EaEalEa ey EAIE S EAIE S XXX EAIE S *

ﬂ'.- With Key-registration , iText can be upgraded to iITextPro -&'

iText is Freeware. But, if you like iText and wish to make it more powerful,
you can change_your copy of iText to iTextPro with Key-registration.

iTextPro is almost the same as LightWayText except for the advanced features
including Macro, Word Services, importing and exporting Unicode format files
(UTF8, UTF16), and Stream Editor, but is only for Macs.

(There is not any plan of iTextPro for Windows.)

Please reqister and pay the Key Registration Fee ($15 per user) at
LightWayText/iTextPro Purchase page;
https://order.kaqgi.com/cgi-bin/rl.cqi?R9X&&lang=en

You can also purchase LightWayText for a Shareware fee of $25 per user.

When you register LightWayText, you will be licensed for both the Mac and PC versions
of LightwayText and the LightWayText Family Applications, including all future versions.
If you have already registered a previous version of LightWayText, you do NOT need to
purchase a new copy or pay an upgrade fee. Your old registration code will still work

with the new version, and you do not even need to re-enter the code.

Both iText and iTextPro are compatible with LightWayText .
So, when you need more features, please step-up to LightWayText !!

For further details, see'Read Me (How to Upgrade)' in separate file.
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The latest information about LightWayText & iText/iTextPro can be downloaded
from the following sites;

LightWayText ; http://members.aol.com/LightWayText/

iText; http://members.aol.com/iText/

iTextPro ; http:/members.aol.com/iTextPro/ #ﬂ

1.1. Whatis iText 3 ?

=% iText follows iMac's Concept !

iText is very popular and is loved by many Japanese, because it has High Speed,
is Cool, Fantastic, and Simple !
iText lets you recall 'the Macintosh mind of the early days' - The original Mac's concept.

In addition to being a normal editor, iText also provides various useful functions
and loveliness !

You will definitely feel iText is a dream tool, which follows those other easy to use
Apple favourites TextEdit and AppleWorks !!

=% Why Freeware ? Anyway, try it out once !!

We made iText to introduce LightWayText to more people around the world.
You will surely find iText is efficient, reliable, attractive and intuitive !!

When you need more features, please step-up to iTextPro or LightWayText ...
‘LightWayText for Windows' and'iText for Windows' are now on release too!

Jo Fo Jo o% % %

Whv not share iText with vour friends ?

We are now gifting 'iTextPro Trial Key' to applicants !

We think it would be great if many of you were interested in iText and
LightwayText . If you find iText as useful as we think you will,
please let your friends know about us !!

If you would care to share iTextPro with your friends, please send us
an email with your email address and that of your friends,

to raphael@ya?2.so-net.ne.jp.

We will send an 'iTextPro Trial Key (effective for 30 days)’
to both you and your friends !

Note that, '"TextPro Trial Key'is NOT available for iText Pro '08 .

(3)


http://members.aol.com/LightWayText/
http://members.aol.com/iText/
http://members.aol.com/iTextPro/
mailto:raphael@ya2.so-net.ne.jp

iText Manual

Please try iTextPro and expect it to please !! ..!:l

1.2. Requirements of iText 3

iText 3.1.7E covers Mac-OS 7.1 onwards, including OS X 10.5 (Leopard).
'iText for Windows 3.1.6E 'covers any Windows.
(Windows 95 and later versions, including Windows-XP)

e The Classic version is for OS 7.1 to OS 9.x.
* The Carbon version (iText-X) is for OS 10.1 onwards,
including Mac OS X 10.5.

0, o

e [Features - Here are examples of useful functions of LightWwayText Family Applications.
All these features are covered in 'LightWayText for Windows 4.1.6E'
and 'iText for Windows 3.1.6E' too!

< Common features of iText/iTextPro & LightWayText are shown in black.
« Cute features applicable to only iText are shown in orange.

< Additional features for LightWayText & iTextPro are shown in green.

< Advanced features applicable to only LightWayText are shown in red.

* To help you see what was upgraded from 3.0.4, the new or improved
features of iText 3.1.7 are shown in Magenta.

File / Window Operations;

Allows you to share LightWayText documents in both Macs and PCs, with just one license.
Both LightWayText for Mac and for Windows are completely compatible with each other.

A LightWayText document made on a PC can be opened on a Mac, also a LightWayText document
made on a Mac can be opened on a PC. Both versions cover RTF and JPEG images, and

have a spell checker too.

Covers all standard file commands of Macs; New, Open, Close, Save, and Print.

Allows you to import and export Rich Text Format files (RTF) and Unicode files (UTF8,16).
Allows you to use longer file names (up to 255 characters on a file),

providing you work with OS-X.

Allows you to open a necessary file quickly with Recent menu, File Browser Tool, and File
Search Tool etc..

Allows you to save and create a backup file automatically.

Allows you to make Self-executing documents like 'ReadMe File' with the ReadMeMaker

which is an accompanying Utility-Program.

Allows you to change the Text format (Macintosh / PC / Unix), and it manages all Japanese
character codes (JIS/EUC) exchanges.

Compatible with all LightWayText documents, both Macs and PC, also with iText & iTextPro ,
our other family applications.

Copes with Multi-windows , Live Scroll , Split Window , and Window Shade .
Allows you to display the windows tiled or on top of each other.

Allows you to change the current active window to the next or the previous window with
Window menus.

Allows you to set the iMac's color variation to the window.
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Allows you to set a variety of colors of the Mac OS X Aqua to the window.

Text Editing;

Allows you to edit text documents of more than 32 k bytes at high speed, provided there is
sufficient memory.

Allows you to check the spelling as you type, or check the whole document in OS-X.
Allows you to put multilingual languages' Unicodes (UTF8,16),

including US-ASCII codes, Japanese, and European languages. (Only effective in OS-X)

Copes with all standard text editing of Macs, does Multi-undoes and Multi-redoes .
Copes with Drag & Drop and AppleScript .
Allows you to insert PICT and JPEG images and the character codes into your document.

Copes with Automatic Indent , Smart Word Edit , and Line Curser Indication.

Copes with TSM (Text Services Manager) inline input.

0S 10.3 onwards - Supports 'Smart Inline Conversion' , providing you use
EGBridgel5 as the Japanese TSM-Inline method.

Copes with J-Wrap (a Japanese hyphenation Function; Kinsoku-Syori).

Allows you to display the Line numbers , and Control codes in document windows.

Has several extra editing commands including Change Case , Capitalize , Duplicate Line ,
Reform Line , and Join Line .

Supports Word Services including Spell Checkers, just like a built-in function.

Allows you to name the contents of a Multi-Clipboard and save each one individually.
You can also share them with 'LightWayText for Windows'.

With the Toolbar, you can quickly execute commands that you use frequently, such as File,
Edit, or Search.

Key Customization;

Allows you to assign special key operations to the Menu commands, Control keys,
and Arrow keys, with the Key Bindings function.

You can also assign specific tasks to the Function keys (F1~F12), and execute them
quickly via the Function Bar .

Find & Replace / Jump / Mark;

Allows you to show the Find Palette and Find Assist Palette for quick search and
replacement.

Allows you to perform complex search and replacement with the Regular Expression
Allows you to do serial pattern searches and appropriate substitutions at the same time for
several files, with the Stream Editor (SEd) and multiple SEd scripts .

Allows you to jump to a particular line or page, also to insert bookmarks and manage them
with the Mark List .

Allows you to find all particular keywords in a document and show them with red dotted lines
- OS-X only.

Character and Paragraph Attributes:

Allows you to change character emphasis, and choose fonts / font sizes / colors and decorations,
also rich variations of each character.

Allows you to make the Font Sizes bigger up to 5,000 points.

Allows you to set Font Smoothing for Quartz fonts Antialiasing. (OS X only).

Allows you to set the Japanese specific character style Ruby (Very small letters).

Allows you to specify a set of Character attributes which you might use frequently for a quick
change of the text appearance, saving it with Define Styles in the name you want.

Allows you to set the indents, margins, and the variable tabs for each paragraph easily.
Allows you to set all the paragraph and character attributes for the whole of the current document

(3)



iText Manual

with the Document command.
Allows you to count the number of items including bytes, characters, words, and pictures,
in the whole document or highlighted selections.

Page Layout / Header and Footer:;

Allows you to set the dimensions of a page, also the Margins , Columns , number of characters
and lines etc., and set the Title Page .

Allows you to set divided Columns , keeping the layout image of one page.

Allows you to display the document with a paper image, and edit keeping that format,

also zoom between 25% and 400%. Zoom 120%b and 125%b are new features.

Allows you to set a header and footer within the document, including the date, time, page,
and the document name.

Custom Paper;

Allows you to design and save a specific Custom Paper , which you might use frequently,
defining a set of dimensions including the paper size, paragraph attributes, character attributes,
and border lines.

Has built in various ready-made papers including Lined Paper , Notepaper , Card, and
Japanese Manuscript papers

Allows you to create spreadsheet-like tables easily with For Tables which provides an
automatic table-setting function by setting the tab stops.

Key Macro;

Allows you to record a series of operations automatically. You can also modify the recorded
macros with the Macro Editor .
Includes various sample macros such as Calender2005 , and Today's Date .

+ Alpha functions:;

For your day-to-day time management, there are other useful little goodies to play with,
including a Scheduler function. A color change of appointment time or indication of message
are possible.

With the Special-Option ( + Click URL) of Preferences, LightWayText & iText/iTextPro
can open the Internet Browser or Mail-Reader with a key selection.

There are also 'LightWayText French version for Mac' and 'LightWayText Italian
version for Mac'.

Also, an English language version of ‘LightWayText for Windows' and
'IText for Windows' are on release! (There is not plan of iTextPro for Windows.)

2. Document Window

The document window of iText consists of the following parts.
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" % File Edit Find Font Size Style Format window

DE@ Untitledl == HIH
Bondi Blue | [E] [EB[=[=[=T] [E[=[ 0 ||+ Format Tools
- (Bl = Ruler

I

Information
area = (| #F P LA £ [ m | [d]n

| [ ]

U] Open| Save| FindMext| Find/Fep || Unda | Cut | Copy | Paste [o]
.T\.

Function Bar

The Ruler and Format Tools can be shown or hidden with Show Ruler or
Format Tools in the Format menu. See 3.5. Format Menu.
The Function Bar can be shown or hidden with Preferences in the Edit menu.

See 3.2.1. Preferences Dialog.

2.1. Ruler

The Ruler is a horizontal scale at the top of the document window, and is divided into inches
or other units of your choice. It can be shown or hidden with the Show Ruler from the
Format menu. When you select the @ symbol, the Ruler unit menu appears.

—— @ Untitled1 === 082
Bondi Blue -] [W] [(B[=[=[=] [=[=[0 |
EUIEF_} ||:|""| |2*|| |4 1 |E |* |E 1 I_Btters
It can change a indent ~ Centimeters
or marging, for each paragraph. Inches
’ paragraph.| | Points
Z Letters

When you drag the markers (= /) in the ruler, the following change.
See 3.5.1. Format Tools.

& marker The first line start position
Left *+ marker The left indent position
Right * marker The right indent position

When you click , the symbol changes to .
Dragging the markers changes the following. See 3.5.3. Page Layout Dialog.

Left *+ marker The left margin position
Right ™ marker The right margin position

2.2. Information Area
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In the Information Area (the document window left lower part) information such as
Line number, Column number, and Page number is displayed.

7 Indicates that the document has been changed and not saved.

[Pi1 Lotoco |
Indicates the current Line number, Column number, and Page number
(Only with Paper Image).

With mouse click can do the following operations ;

Double click LC Displays the Line dialog

Option + LC: Moves the cursor to the last line
Option + Shift + L:C Moves the cursor to the first line
Command + L:C: Displays the Line dialog

Click P: Displays the next page

Shift + Click P Displays the previous page
Option + Click P Displays the last page

Option + Shift + P Displays the first page
Command + P Displays the Page dialog

2.3. Special Operations

Selecting the Title bar with the Option key, the Window-shade operates, and when you click
the close-box with the Option key, all document windows are closed.

Clicking in the document while holding Control , opens a popup menu.

With it, you can select a menu you use frequently including Spelling .

+ Click URL or email-address

You can open the Internet Browser or Mail-Reader with a key selection.
When you click while holding the Command key the URL-strings like
"http://www.apple.com/main.html", it launches your Internet Browser,
and shows the homepage.

If you Command click an email address string like "lightway@mac.com",
it launches your Mail-Reader.

When you click it with the Option + Command keys on, it is only choice of the
URL or email-address, and the Browser or Mail-Reader is not launched.

When you choose 'About iText..." from the Apple menu, it displays the version of iText.

When you choose 'iText Pro Key..." from the Apple menu, it displays more Dialog to
register to iTextPro .

iTextPro is almost the same as LightWayText except for the advanced features including
Macro, Word Services, importing and exporting Unicode format files (UTF8, UTF16),
and Stream Editor.

If you like iText and wish to make it more powerful,

please reqgister and pay the Key Registration Fee ($15 per user)

at LightWayText/iTextPro Purchase page;
https://order.kagi.com/cgi-bin/rl.cgi?R9X&&lang=en
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When you register iTextPro , a new menu of ‘Go to iTextPro' appears.

When you select it, your copy of iText itself changes to iTextPro , and the menu changes
to '‘Back to iText' .

With these commands, you can switch between iText and iTextPro at any time.

For further details, see 'Read Me (How to Upgrade)' and'iTextPro Manual’

in separate files.

The latest information about iTextPro can be downloaded from the following sites;

http://members.aol.com/iTextPro/

3.1. File Menu

Mew 3N
Open... %0
Close 3
Save %
$ave As...
ReverttoSaved
Fage Setup...
Print... #®P

" uit 1)

New

Open...

Note:

Close

Save

Save As...

Makes a new document window.

Displays the Open dialog to open any text document.

The list box also includes the names of any unformatted ASCII text documents
of Macintosh file type "TEXT". i Text 3.1.1 onwards supports

importing Rich Text Format (RTF) files.

In addition, it shows '.LWT" and '.iTE"' documents which are the specific
formats for 'LightWayText for Windows 'and 'iText for Windows .

If you select a file made with Windows with accented characters,

iText identifies these characters and converts them to Mac's

character codes.

If you intend to import a .rft document, ensure you select "All Documents”
in the Show list of the Open window, so the RTF documents will appeatr.
iText identifies "Rich Text Format (.rtf)" automatically and opens them.

Rich Text Format (RTF) is a Microsoft word processing document format,
that encodes Word formatting in plain ASCII codes to allow easy interpretation
by other programs that read this format. iText opens Rich Text Format files
so that comparable character and paragraph formatting can be interpreted
from the other programs.

Note that, because of differences in each program, some features may not

be transferable, including outlining levels, styles, tables, color, and

hidden text format.

(iText is unable to read RTDF documents at present, but this feature

will be available in the next version, coming soon.)

Closes the document window.
Saves contents of an open document.

Displays the Save As dialog to save with another name.
i Text 3.1.1 onwards supports exporting Rich Text Format (RTF) files.
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Quit
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If you intend to export a .rft document or an unicode file, ensure you have
selected Rich Text Format (.rtf) from the Format option in the Save As
dialog. If you are using an earlier operating system including Mac OS7,

there is no Format option in the Save As dialog due to OS restrictions.

If you intend to save your file as a .rft document in the earlier OS, ensure

you have put '.rtf ' as the extension at the end of the file nhame before you save.

When Rich Text Format (.rtf) is selected, iText saves your document
as a Rich Text Format file so that comparable character and paragraph
formatting can be interpreted by other programs.

Note that, when you save your document as RTF, some features of iText and
LightWayText, including PICT/JPEG pictures, Ruby, Upper lines,

Fill Patterns and Colors, Marks, and Custom papers are not retained,

due to RTF specifications.

Also, because of differences in each program, some features may not

be transferable, including outlining levels, styles, tables, color, and
hidden text format.

Unicodes characters can be retained among TextEdit, but may not be
available for many Windows programs in Rich Text Format (RTF) due to
Microsoft restrictions. Note that unicode's characters require OS-X onwards.
See Unicodes Information in 3.4. Font, Size, Style Menu (Text Menu).

If you want to make a document that you will use many times, e.g. a letter,
you can save it as a Stationery Pad . To save the document as it actually is,
specify Stationery form Stationery Option in the Get Info dialog,
after you click on a documents icon on the Finder.

Opening it starts with the untitled document.

iText-X also allows you to use longer file names (up to 255 characters
on a file), including unicodes.

If you wish to save a "iText" document for a PC, please step up to
LightWayText .

Cancels of all changes, to make the contents back into the last saved document.

Displays the Page Setup dialog.
Prints contents of the document.

Quits the iText application and all open iText documents.

If you have made changes to a document without saving, iText presents a
message asking "Save changes to the file ?"

If the document is untitled, it displays the Save As dialog.

When you upgrade to LightWayText or iTextPro ,

you will have more commands available including Recent and Browser .
LightwayText supports importing and exporting Unicode format files

(UTF8, UTF16), and allows creating a plain-text document to serve as RSS code
sheet, too.

If you often share documents between a Mac and a PC, please step up to
LightWayText .

LightWayText also allows you to change the Text Format to PC or Unix,
and to save the document available for 'LightWayText for Windows' __and
'iText for Windows'
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Undo 7
Cut £
Copy ®C
Paste |
Clear

Select All #A
Spelling... % :
Preferences...
Show Clipboard

Note:

Undo

Cut

Copy
Paste

Note:

Clear
Select All

Spelling...
Note:

Preferences...

Show Clipboard

iText Manual

Spelling is not shown
before OS 9,

only available in OS-X.

Spelling is only available in OS 10.2 onwards .

Reverses your last editing or formatting action.
If you have typed or used any commands that you can reverse, its name
and the count appears e.g. Undo Typing , Undo Copy .

Deletes the selection and puts it onto the Clipboard, replacing the previous
contents.

Sends the selection to the Clipboard, replacing the previous contents.
Inserts a copy of the Clipboard at the insertion point or replaces the
highlighted selection.

iText 3.1.1 onwards supports replacing Rich Text Format (RTF) codes
and Unicodes (UTF8,16) on the Clipboard.

When you copy text from one program to another, character and paragraph
formatting of Rich Text Format or Unicodes (UTF8,16) are retained
provided the other program can read them.

iText-X is completely compatible with TextEdit, and allows your

texts with character formatting and even unicodes characters including
Japanese Hiragino Kanji characters and Hiragino Gaiji (Grif ID) characters
to share between TextEdit, using '‘Drag & Drop' and 'Copy & Paste' too.

Note that, because of differences in each program, some features of

Rich Text Format may not be transferable, including outlining levels,
styles, tables, color, and hidden text format. Remember that, unicodes
characters are only effective in OS-X. See 3.1. Open, Save As commands,
and 3.4. Font, Size, Style Menu (Text Menu).

Removes the selection, without placing it on the Clipboard.
Selects all contents of the current document.

Displays the Spelling dialog in OS-X. See 3.2.2.1. Spelling Dialog.

Spelling is only available in OS 10.2 onwards .
If you are using OS 10.1 or earlier, this command is not available.
For more details about how to check spelling, see 3.2.2. Spell Checker.

Displays the Preferences dialog. See 3.2.1. Preferences Dialog.

Displays the clipboard.
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When you upgrade to LightWayText or iTextPro ,

you will have more commands available including Multi-undoes , Multi-redoes
Paste Special , Page Break , JPEG Picture , Extra, Key Macro ,

Key Bindings , Multi-Clipboard , and examples of what you can make with
Multi-Clipboard

With 'LightWayText for Mac' and 'LightWayText for Windows'
Multi-Clipboard also allow you to_share Scrap Catalog file between a Mac

and a PC.

LightWayText-X and iTextPro-X also have a Spelling sub-menu.
With this, LightWayText-X and iTextPro-X also allow you to check the
spelling as you type, or to check all errors throughout the document with
Check All Spelling

3.2.1. Preferences Dialog

The Preferences dialog is displayed when you choose Preferences... from the Edit menu.
It controls many default settings for iText and shows the present conditions.

Freferences
Color Mariation: | Il Bondi Blue

Startup: [ New Window~] &= Show Ruler
Units: 2 show Info iea
Ruler: ow invisibles

E Flow Lines

Justify: & Show Page Guides

J-Wrap: O $how Paper Image

Font: [ Genenua *] @ FormatTools
o . O Wordwrap

5'2“-_ 12 ] [Z] Points O Smart Word Edit

Tabs: Letters & Function Bar

4
Line: [0 | Points

Color Variation Specifies which color you want to set as iText's default window.
If you wish to define it freely color, choose Preference.
It displays the Color Preference dialog.
See 3.2.1.1 Color Preference Dialog.

Startup Specifies the startup action with iText.

Units Specifies the units to use with Page Layout dialog.

Ruler Specifies the ruler units for the new documents.

Justify Sets the paragraph alignments to Left, Right, Center, or Justified ,

for the new documents.

If you choose Justified , it adjusts the contents, equally between both edges,
and if there are spaces (or Japanese Single byte Spaces), it does this
uniformly by expanding spaces.

J-Wrap (Only in Japanese Font use)
Specifies the method of Japanese-Word Wrap for the new documents.
If you specify either the Dangle or Expel, it achieves the Japanese-Word
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Wrap by this method. (This special function is called the Kinsoku-syori
in Japanese, frequently translated into English as the Japanese Hyphenation
Function. It neatly handles the Japanese characters that must not be at the
start and end of lines.)

When you choose Dangle, it puts the target characters at the end of the line.
Also, if you choose Expel, it sends it to the start of the next line.

Specifies the default Font for the new documents.
Specifies the default Font Size for the new documents.

Specifies the default Tab Width for the new documents, with the character
numbers of the default font size.

Specifies the default Line Interval for the new documents, with the number
of points.

Show Ruler , Show Info Area , Show Invisibles

When checked, iText displays these items in the new documents.

Flow Lines , Show Page Guides , Paper Image

When checked, iText shows the new documents in these formats.

Show Format Tools

Note:

Wordwrap

Smart Word Edit

Function Bar

Note:

When checked, iText shows the Format Tools within the new windows ruler.

For details about these formats, see 3.5. Format Menu.
All changes in Preferences apply to documents made after the change only.
Even if you change them on the way, existing documents are not changed.

When checked, iText achieves Wordwrap with the new documents,

to prevent separating a word in the line.

As you type and reach the end of a line, and the last word if it is incomplete
within the line, the word automatically moves to the next line.

Normally Wordwrap is always checked.

When checked, adjusts the spaces between words (English, or French etc.)
after cut, paste, delete or, Drag & Drop for new documents.
This does not apply to Japanese.

When checked, iText displays the Function Bar .
With this, you can execute some commands quickly.

When you upgrade to iTextPro , you will be able to assign commands
to the Function Bar .

Function Bar Example:

Bl pen. | save TrndbetfFndfepl]l Undo ] oot § Copy {Pacte T

3.2.1.1. Color Preference Dialog

Color Preference dialog is shown if you choose Preference from Color Variation
in Preferences dialog or color lists in the Format Tools .
With this, you can define your iText's default window color freely.
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Color Preference Ss————|

Title: |Preference 1... |

~ Ruler/Line#/ Info Area
» Appearance Color < Fore Color

® BaclColor

...... Inuisihles}l’age ﬁ“ides eereseseanrmsmsrereneeeeaneaasans
[ TabCode | [RerurnCode |
[ Space Code | [ Fage Guides|

Title Defines the name for the Color Variation.

Ruler / Line#(Line Numbers) / Info Area
Selects what you want to specify.

Appearance Color
When checked, iText sets the Appearance theme color of your Mac
(OS 8.5 and later versions).
If the new Appearance Theme will be offered for the future Mac OS,
the new color should be applied to this.
(It is not available before OS 8.5.)

Fore Color
When checked, iText sets the Fore theme color of your Mac
(OS 8.5 and later versions) to the indication characters' color.
This option allows you to set the default indication characters' color
in the Ruler and Line number, separately from the Appearance Color .
It would meet your requirements of Aqua-color in OS-X.
If the new Fore Theme will be offered for the future Mac OS,
the new color should be applied to this. (It is not available before OS 8.5.)

Back Color / Fore Color

If you wish to specify the background's and the indication characters' colors
in the Ruler and Line number, click on these and then choose the color
you want.

Back Color

Specifies the background color.
Fore Color

Specifies the characters' color.

Invisibles/Page Guides

If you wish to define colors for each special code, click on these and then
choose the color you want.

Tab Code. Defines the Tab codes and the other control codes color.
Return Code . Defines the Line Feed (Return) and the

Page Feed (Page Break) code's color.
Space Code. If you wish to make the Space codes visible, define this.
Page Guides . Defines the color of Page Guides and the outside

of paper image's.
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3.2.2. Spell Checker (Only available in OS 10.2 onwards )

From OS 10.2 onwards , iText-X has a Spelling menu in the Edit menu.
With this, you can run the OS X spell checker (NSSSpellChecker ) in iText
as if it were a built-in function. If you have installed CocoAspell , this is available also.

To correct errors or change the dictionary, select the Spelling... .
iText displays possible alternatives in the Spelling dialog.
For more details, see 3.2.2.1. Spelling Dialog.

Note: Spelling is only available in OS 10.2 onwards .

Find Font §
Can't Undo i

iText File

Cut FBEX
Copy LA
Paste #H\
Clear

Select All A

Preferences...

Show Clipboard

When you upgrade to LightWayText or iTextPro ,
you will have more helpful Spelling commands available including
Check Spelling As you type , Check All Spelling , and Find Keyword...

3.2.2.1. Spelling Dialog

The Spelling Dialog is displayed when you choose Spelling... from the Edit menu.
With this, you can check each error in turn and correct it.
This dialog also allows you to change the dictionary.
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o0 spelling
Guess Ignore
Sample
( Guess :1
{ Find Next )
' Samnple| E"'"‘EIHTEE‘IE'"""
Dictionary
f :
_English I-H ( Forget :1 ( Learn j
#
Guess List The left list box shows possible alternatives for the
highlighted word in the document.
Select the guess you wish to use and click Correct ,
or double click it.
If you want to add a word to the Guess list, type the word
in the Correction Box and click Guess.
Ignore After checking, skips the highlighted word in the document.
Note that, when you quit iText, all Ignored spellings
are cleared and do not appear the next time you launch it,
due to restrictions in the spell checker of OS-X.
Guess Displays possible alternatives afresh for the word in the box.
Find Next Searches for the Next occurrence of misspelling.
iText jumps to the next misspelled word and highlights it.
Unknown or misspelled words are shown with red dotted underlines,
e.g. 'Migspellied.
Correct Replaces the highlighted word in the document with the alternative
selected in the Guess List or typed into the Correction Box.
Note: Due to restrictions in the spell checker of OS-X, it is impossible

to correct all same errors at one time with this dialog.

However, if you use Find/Replace... command in Find menu
together, you can correct all the same errors in the whole document
at a time. Follow the procedures below, but still keeping this dialog.

1. Select a misspelled word in the document.
2. Select Find/Replace... command in Find menu.
You should see the misspelling as Find expression in Find String .
3. Specifies what you want to correct with the Replace expression
in Repl String.
4. Check Show Find Palette and click Find.
iText searches for the Next occurrence of misspelling,
and the first-searched is shown with Show Find Palette .
5. Check Replace All in Show Find Palette .
iText searches for all occurrences of misspelling
throughout the document, and corrects all same errors at a time.
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Dictionary Displays the dictionary you want to use for checking.

Learn Adds the word in the Correction Box to the dictionary selected.
Note that, the words specified in the Correction Box are not saved as
alternatives, are just assigned as the target of checking.
Also, if you change the dictionary, the added words are not learned
in them. These are due to restrictions in the spell checker of OS-X.
If you want them to learn to another dictionary too, make them learn
again.

Forget Removes the word in the Correction Box from the dictionary selected.
After checking, iText does not search the occurrence
specified in the box as misspelling.

Note: Remember that, the error marker is NOT saved when the document
is closed. Also, if you move the cursor onto another word,
the red dotted underline disappears.
These are due to restrictions in the spell checker of OS-X.

3.3. Find Menu

Find/Replace... #F
Find Next #0
Find Selection #H
Enter Find 5tring  %E
Replace =
Replace & Find Next &R
Replace All
Line... #,
Fage...
Mark... 3EM|
Find/Replace... Displays the Find/Replace dialog, in order to specify the Find
and Replace expression. See 3.3.1. Find/Replace Dialog.
Find Next Repeats the last Find or Find Selection commands,
and searches for the Next occurrence of the find.
When you select it while holding the Shift key,
it searches backwards towards the beginning of the document.
Find Selection Searches for the Next occurrence of the Find expression with the
current highlighted selection.
When you select it while holding the Shift key,
it searches backwards towards the beginning of the document.
Enter Find String Places the current highlighted selection in Find String
as the Find expression.
Replace Changes the highlighted searched to the Replace expression.

Replace & Find Next  Executes the Replace command, and then executes the Find Next
command sequentially. It changes the highlighted searched to the
Replace expression, then searches for the Next occurrence of the
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Find expression. When you select it while holding the Shift key,
it searches backwards towards the beginning of the document.

Replace All Changes all occurrences of the Find expression in the document
to the Replace expression.

Line... Displays the Line dialog. See 3.3.2. Line Dialog.
Page... Displays the Page dialog. See 3.3.3. Page Dialog.
Mark... Displays the Mark dialog, in order to remember the position

like a bookmark. See 3.3.4. Mark Dialog.

When you upgrade to LightWayText or iTextPro ,
you will have more commands available including Word Services ,
File Search , Stream Editor , and Mark List .

3.3.1. Find/Replace Dialog

Find/Replace dialog is displayed when you choose Find/Replace... from the Find menu.
It specifies the Find expression (Find String) and the Replace expression (Replace String).

Find/Replace

Find $tring :

KKl

ReplString :

& Ignore Double bytes Foman OFind Baclarards
El Ignore Sinae byte katal:ana
E Ignore Case O5how Find Palette

[Dontind] [ Cancel |

Find String Specifies what you want to search for with the Find expression of
character strings.

Repl String Specifies what you want to replace with the Replace expression of
character strings.

Note: Due to Unicodes restrictions, any unicode characters are impossible to find.
Make sure you do not put any unicode characters in the Find/Replace
expressions.

When you upgrade to LightWayText or iTextPro ,
you will also be able to search with the Regular Expression.

Point on |E| Use the arrow to select or clear the history expression.
If you wish to insert the Return or Tab code into each expression of
the character strings, choose Enter Return Code or Enter Tab Code .

Ignore Double bytes Roman (Only in Japanese Font use)
When checked, iText searches for both Alphanumeric
characters' occurrences of Zenkaku-Moji (Double bytes)
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and Hankaku-Moji (Single byte) of the Find expression.
If you uncheck this option, it distinguishes Hankaku-Moji (Single byte)
from Zenkaku-Moji (Double bytes) and searches for the exact match of
Hankaku-Moji occurrences only in the Find expression.

Ignore Single byte Katakana (Only in Japanese Font use)

Ignore case

Find Backwards

When checked, iText searches for both Katakana occurrences

of Zenkaku-Moji (Double bytes) and Hankaku-Moji (Single byte) of

the Find expression.

If you uncheck this option, it distinguishes Zenkaku-Moji (Double bytes)
from Hankaku-Moji (Single byte) and searches for the exact match of
Zenkaku-Moji occurrences only in the Find expression.

When checked, iText searches for both Upper/Lower cases'
occurrences of the Find expression.

If you uncheck this, it distinguishes Lowercase from Uppercase and
searches for the exact match of Lower and/or Uppercase in the Find
expression.

iText normally searches forward towards the end of the document.
When checked, searches in reverse, towards the beginning of the document.

Show Find Palette

Find

Cancel

Don't Find

3.3.3.1. Find Palette

When checked, after searching, iText displays the Find Palette .
With this, you can search and replace the document quickly.
See 3.3.1.1. Find Palette.

Searches for the Next occurrence of the find.
The first-searched is shown with highlighted selection.

Closes the Find/Replace dialog. All changed in the Find/Replace dialog
becomes ineffective invalidity and reverts to the previous setting.

Closes the Find/Replace dialog. It only establishes the contents of
Find/Replace dialog, does Not search.

Find Palette is shown, only when you check Show Find Palette in the Find/Replace
dialog, then click Find button. With this, you can search and replace the document quickly.

Find Palette =—Fr—x|

| Replace | [Repl&Find] [ Find |

(Replacefll] [ GoBack...] [ Quit |

Find

Replace

Repl & Find

Searches for the Next occurrence of the Find expression.
The first-searched is shown with highlighted selection.

Changes the highlighted searched to the Replace expression.

Changes the highlighted searched to the Replace expression,
then Next searches for the Next occurrence of the Find expression
sequentially.

If you push these while holding the Shift key, it searches backwards
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towards the beginning of the document.

Replace All Changes all occurrences of the Find expression in the document to
the Replace expression.

Go Back... Displays again the Find/Replace dialog. See 3.3.1. Find/Replace Dialog.

Quit Closes the Find Palette .

3.3.2. Line Dialog

Line Dialog is displayed when you choose Line... from the Find menu.
With this, you can jump the cursor to any line in your document quickly.

Line

GoToLine:[1__ |Line

Go To Line Specifies which line numbers you want to move the cursor.

3.3.3. Page Dialog (Only in Paper Image)

Page Dialog is displayed when you choose Page... from the Find menu.
(Only when you have checked Paper Image in the Format menu are these commands available.)
With this, you can display any pages in your document quickly.

Fage

GoToPage:[1__ | Page

Go To Page Specifies which page numbers you want to see.

3.3.4. Mark Dialog

Mark Dialog is displayed when you choose Mark... from the Find menu.
With this, you can set the Marks in the document as you would use a bookmark for a quick
access to a specific page in a book.

To set the Mark, select the specific position or the highlighted selection you want to display
in your document, then select the Mark command.
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Marlk:

&

m

Mark: Mame:

[ Delete | [ Cancel | Iﬂddl

Mark List Shows the saved Marks.

Mark Name Specifies the Mark name.

Add Adds the Mark to the Mark List.

Delete Removes the selected Mark from the Mark List.

Type the Mark Name, then click Add button. If you have selected the specific texts
before displaying this, you would see the current selections in Mark Name box.
You can also change it to the other Mark Name.

Note: The saved Mark Names appear at the bottom part of the Find menu.
When you choose it, iText shows the corresponding position.

When you upgrade to LightWayText or iTextPro , you will also be able
to edit the Mark List to show the marks as hierarchical chapters.

3.4. Font, Size, Style Menu (Text Menu)

Font, Size and Style commands change the Character attributes of the selection.

;
)

Pafirda | [<Plain  %T
@ Bedd B
<18 flak ¥l
& lll'kr!l'la U
18 Ui in el
oo Shada
Condlerne
] JExtend
BB <M Black
Larger H Red
JSmaller M Green
Other... M Elue
M Cyan
H Magenta|
Bl Yellow
] other...
Font Displays a list of fonts.

Selecting a font changes the selected characters.

Unicodes Information:

iText-X allows you to use multilingual languages' Unicodes (UTF8,16),
including Japanese, European languages, Greek, Hebrew, Arabic, and Turkish,
also mathematical symbols. Ensure you have selected the appropriate font from

(21)



Size

Larger
Smaller

Other...

Note:

Style

Color

Other...

iText Manual
the Font menu before you put it.

To put unicode characters as it actually is;
1. Choose Show Character Palette from Language Menu
(right of Window menu).
This will display the Show Character Palette window.
2. Select the Unicode you require in Show Character Palette window.
iText puts the character in your document.

If you intend to combine a character and an accent such as acute, grave, circumflex,
umlaut, and tilde as one character using unicode, make sure you select specific
0OS-X fonts including American Typewriter , Baskerville , Copperplate ,
Futura , Lucida Grande , and Optima from the Font menu.

If you select any fonts like Geneva, Helvetica , Chicago , and Times that

depend on QuickDraw, you can not combine them with an accented character,

due to Carbon application's restrictions.

When you intend to use Japanese unicodes characters, you should select Hiragino
from the Font menu. Hiragino support AdobeJapanl-5 character set

which allows you to use over 20,317 characters, including a huge amount of
Hiragino Kanji characters and a variety of Hiragino Gaiji (Grif ID) characters.

To use the Japanese unicode characters as they actually are, you can also put them,
through the Japanese input method tool like Kotoeri and EGBridge.

Hiragino would solve the problems which would be one of the most serious for
many Japanese who feel dissatisfaction for a lack of the Japanese characters' set.

It allows you to put and print your name correctly, even if your name includes

too old Chinese characters.

iText-X is completely compatible with TextEdit, and allows your texts

with multilingual languages' unicodes characters including Japanese Hiragino

Kanji characters and Hiragino Gaiji (Grif ID) characters to share between TextEdit
and Japanese word processor EGWord, with 'Drag & Drop' and 'Copy & Paste’ too.

Note: Unicodes are only effective in OS-X.
Unicodes characters are compatible with other text editors
provided they support unicodes. If you open the document having
the unicodes with another text editor that does not support unicode,
you might find some wicked strings at its position,
but there are no problems.
Make sure, due to Unicodes restrictions, unicode characters are
impossible to find with Find .

Displays a list of Font sizes.

Selecting the size changes the size size of the selected characters.
Makes it 1 point large than the current setting.

Makes it 1 point small than the current setting.

Displays the Font Size Dialog. See 3.4.1. Font Size Dialog.

iText 3.1.5 onwards increases the Font Sizes up to 5,000 points.

Displays a list of Text-Styles.
These commands change the attributes of the selected characters.

Displays a list of text colors.
These commands change the text color of the selected characters.
Displays the Text Color Dialog.
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If you wish to change the characters to any other colors,
choose this and select the color you want.

o

When you upgrade to LightWayText or iTextPro ,
you will have more commands available including Superscript ,
Subscript , Line Style , Fill Pattern , Ruby, and Define Styles .

3.4.1. Font Size Dialog

The Font Size Dialog is displayed when you choose Other... from the Size menu.
With this, you can change the size of the characters.

Font Size =—Fce—F=

Size: [12 | Points

Size Specifies which points you want to change to.

Note: iText 3.1.5 onwards increases the Font Sizes up to 5,000 points
in response to user requests. Allows you to make the font size bigger.

3.5. Format Menu

Format commands change the appearance of your document, including the size, shape,
layout and paragraph attributes.

+ Show Ruler

« Show Info Area
Show Invisibles

+Flow Lines

« Show Page Guides
Faperimage
Hertical Direction

Document... 3y
Fage Layout...
Header...
Footer...
Show Ruler When checked, iText displays the ruler at the top of the document
window. See 2.1. Ruler.
Show Info Area When checked, iText displays information such as line number,

column number and page number at the left lower part of the
document window. See 2.2. Information Area.
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Flow Lines

Note:

Show Page Guides

Paper Image

Vertical Direction

Format Tools

Document...

Page Layout...

Header...
Footer...

iText Manual

When checked, iText displays the special codes such as return and
tab as grey symbols.

When checked, iText flows the characters onto the next line

at the margins, as a soft line break. If you have indents set,
iText flows the characters at the indent positions,

which have priority over the margins.

If unchecked, iText does not flow the characters onto the

next line until the next return code and the characters continue
beyond the margin. This might be useful for programing.

Flow Lines should normally be checked so the characters flow
onto the next line.

To set margins or indents, see 3.5.1. Format Tools,

3.5.3. Page Layout Dialog.

When checked, iText displays page guides showing the width and
height of the page with dotted lines.

When checked, iText displays the document with one page showing.

When checked, iText turns the paper to write the Japanese
characters vertically.

This is Tategaki , a Japanese Vertical Writing format, normally
used for Japanese books.

When checked, iText shows the Format Tools within the windows
ruler. See 3.5.1. Format Tools.

Displays the Document dialog, to apply the unified paragraph
attributes to the whole document. See 3.5.2. Document Dialog.

Displays the Page Layout dialog, to set the dimensions including
the margins and columns of your document.
See 3.5.3. Page Layout Dialog.

Displays the Header dialog, to insert a header in your document.
Displays the Footer Dialog", to insert a footer in your document.
See 3.5.4. Header Dialog (Footer Dialog).

When you upgrade to LightWayText or iTextPro ,

you will have more commands available including Show Line Numbers ,
Paragraph , Tabs, View Size, Text Format , Custom Paper ,

and some ready-made papers including Lined Paper, Manuscript Paper,
and Address Paper.

If you often share documents between Mac, PC and Unix , please step up to

LightwayText . LightWayText allows you to convert the document format
available for PC or Unix. LightWayText also allows you to save the document

available for 'LightWayText for Windows' and 'iText for Windows'

3.5.1. Format Tools
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The Format Tools give you quick access to set the options such as the window's color and
the Paragraph attributes. With these, you can set the indents each paragraph, and set the
margins easily. Also, this allows you to set the iMac's color variation to the window.

The Format Tools can be shown or hidden with Format Tools command from the Format menu.

It also appears or disappears by double clicking scale of the ruler.

Bondi Bluz | BR[=|=[=] [==]o ] | — Format Tools
s AP SR LU SR N & P S L S
[ BondiBlue | Lists and changes the iMac's color variations.

Select the color you want to set for the ruler and
Information Area.

Bondi Blue
Bluebierry
Grape
Tangerine
Lime
Strawberry
Graphite
anow White
Indigo

Ruby

Sage

key Limne
Classic

AR RRRRRRRRRR

Click this to toggle between the Paragraph attributes
and the Page Layout .

When this symbol is shown, you can set the Indents
as the Paragraph attributes to the selected paragraphs.

When you drag the markers (® /) in the ruler, the following change.

Note:

& marker
Left * marker
Right * marker

The first line start position
The left indent position
The right indent position

When you upgrade to LightWayText or iTextPro ,

you will also be able to set the variable Tabs.

When this symbol is shown, you can set the Margins
as the Page Layout for the whole document.

When you click , the symbol changes to .

Dragging the markers changes the following. See 3.5.3. Page Layout Dialog.

Left * marker
Right * marker

The left margin position
The right margin position
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When you click the following tools, it changes the Alignment , or
Line Spacing of the selection.

Alignment

(Justify) Line Spacing
E— ——
B=E=E=] _EEo]

Alignment of Paragraphs (Justification)
These tools change the alignments of the selected paragraphs
or as indicated with the cursor.
If you click he right hand Justified symbol it adjusts the contents,
equally between both edges, and if there are spaces
(or Japanese Single byte Spaces), it does this uniformly
by expanding spaces.

Flush left Flush right

Centered Justified

Line Spacing
These tools change the spaces between the lines of the selected
paragraphs or as indicated with the cursor.
Indicates the specified space with points.

Narrows 1 point

Expands 1 point

When you click the Narrow or Expand buttons,

iText increases or decreases the spaces by one point.

If you keep the Narrow and Expand buttons depressed more than
1 seconds, you can change the line spaces sequentially,

from 1 up to 100 points.

Note: When you upgrade to LightWayText or iTextPro ,
you will also be able to set the Character Spacing .

3.5.2. Document Dialog

The Document dialog is displayed when you choose Document... from the Format menu.
It sets all the paragraph and character attributes for the whole of the current document.
Naturally you can change the attributes of any paragraph or character individually.

But if you have a document with a mixture of attributes and wish to create a unified set,
use this dialog before you start editing the document or after you have finished.
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|———————== Document
d“ﬂifu: ..[‘_‘nunt ........................
J-Wrap:[_Nothing_~ | Letters: @
. 2 Baptes: a
Font: [ Geneva - | 1 Buytes: g
Size: [=] Points I:lll'ilh:lﬁ: 1
Tabs: [¢ |lettersOWorduwap | Lipes: i
Line: [0 |Points Fam: !
B Font & Size affect all Butes: 0

Justify Sets the paragraph alignment to Left, Right, Center, or Justified .
If you choose Justified , it adjusts the contents, equally between both edges,
and if there are spaces (or Japanese Single byte Spaces), it does this
uniformly by expanding spaces.
Notice, the paragraphs are arranged relative to the left and right indents
rather than the margins.

J-Wrap (Only in Japanese Font use)
Specifies the method of Japanese-Word Wrap.
If you specify either the Dangle or Expel, it achieves the Japanese-Word
Wrap by this method. (This special function is called the Kinsoku-syori
in Japanese, frequently translated into English as the Japanese Hyphenation
Function. It neatly handles the Japanese characters that must not be
at the start and end of lines.)

When you choose Dangle, it puts the target characters at the end of the line.
Also, if you choose Expel, it sends it to the start of the next line.

Font Specifies the Standard Font for the whole document.
Size Specifies the Standard Font Size for the whole document.
Tabs Specifies the Standard Tab Width for the whole document, using the character

numbers of the Standard font size.

Wordwrap When checked, iText achieves Wordwrap for the whole document,
to prevent part of the last word in the line being continued onto the next line.
Normally Wordwrap is always checked.

Line Specifies the Standard Line Interval for the whole document, using the number
of points selected.

Font & Size affect all
When checked, iText changes all characters within the document
to the Standard font and size.
If unchecked, it does not affect the current situation.

Count Displays the number of items in the whole document, or the highlighted selection.

Words (iText 3.1.2 onwards) shows the number of 'words';
a 'word' being a group of characters separated by a space.
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3.5.3. Page Layout Dialog (Only in Paper Image)

The Page Layout Dialog is displayed when you choose Page Layout.. . from the Format menu.
It allows you to set the dimensions of a page, also the margins, columns, number of characters
and lines etc.. These dimensions are based on a page-size specified with Page Setup command
and affect the whole current document, only effective in Paper Image .

You can also change the units (cm or inches) for setting this dialog,

with the General Preferences dialog of the Preferences command.

Fage lagnut

=
=3
S
2
E

- Hargin .............................. :

Top: [1.20 |em i Number:[i__ |Col
Bottom:[1 20 | cm i Space: [0 |em
Left: : em | Width: 1352 cm
Right: em |

Width: 1252 em  C/line:[22__|char
Height: 2727 cm  L/Page:[62 |Line

§tart FageNumber :[1__ | Page

Margin Specifies each Margin in the current document.
You can also specify these quickly with Format Tools .
See 3.5.1. Format Tools.

The Margin is the space between the edge of the paper and the main text area,
you can use margins for the whole of the document.

If you wish to vary the distance between the text and margins for part of a
document, you had better change the indents to only the selected paragraphs
with Paragraph command, not use this.

Notice the difference between Margins and Indents, the Margins are the spaces
between the edges of the page and the edges of the main text area, and these are
effective throughout your document. The indent determines the distance from
the specific lines or paragraphs to the left or right margin boundaries,

and you can set each individual paragraph.

For the Indents, see 3.5.1. Format Tools.

Column If you wish to divide your document into columns, you can set up to five on a page.
When you set columns, you can also set the distance between them with Space.
All spaces will be the same.

Number Specifies the number (2~5) of columns to divide within the page.
Space Specifies the interval between columns.
Width Shows the size of the columns.

All columns will have the same dimensions.

Width, Height
It shows the number of the characters and lines of a page.
These values will increase or decrease by changing the Margins or Columns.

Width Shows the width of a page.
Height Shows the height of a page.
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C / Line Shows the number of characters with Standard font size of one line.
L / Page Shows the number of the lines with height of 1 page.

Start Page Number
It allows you to set the title page. If you wish not to count the first page of the
current document, specify 0.
It can set any of numbers (-99 to 999), iText takes this number into
consideration and counts, indicates, and prints the page numbers in your document.
When set to less than 1, iText will not indicate and print the page numbers,
Header, and Footer until page 1 of your document.

3.5.4. Header (Footer) Dialog (Only in Paper Image)

The Header or Footer Dialog is displayed when you choose Header... or Footer.. .

from the Format menu. It allows you to set the header and the footer within the document.
The Header is text which indicates and prints in the top margin of each page of a document,
and the Footer appears and prints in the bottom margin.

Both are only effective in Paper Image , when unchecked, these not appear nor are printed.
Also, if the Start Page Number is less than 1, these do not appear nor are they printed.

Header
Height: cm History: [*]
String:
Stamp: [>] DateType:[>] Time Type:[~]
- Header Style
: Font: [ Geneva - |

ESize: |E|Fnints EPlain O0O0dDG

 Color: [ W Black_~ EFf:lﬁi Emﬁ'l
 Justify: [left ~] OUnledine OExtend

Height Specifies how much height to display at the top (or the bottom) blank of paper.
Available values are limited by the top or bottom margins.
So, if you wish to take these equal to or more than one line, extend the top or
bottom margin before setting this. See 3.5.3. Page Layout Dialog.

String Shows what you want to display in the Header or Footer in character strings.
You can also set the following descriptive Stamps that could be frequently used
in Header or Footer.

History Use the arrow to select or clear the history expression.
If you wish to insert the Return code into the expression of

the character strings, choose Enter Return Code .

Stamp Displays a list of Stamps, use the arrow to select Stamp you want.
When you select one, it is inserted in the String box with the
following forms.

Date Indicates as <DATE>.
It will display the current date on your document.
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Time Indicates as <TIME>.
It will display the current time on your document.

Page # Indicates as <PAGE>.
It will display an each actual page number on your document.

Total Page #
Indicates as <PMAX>.
It will display the total page number on your document.

Document Name
Indicates as <NAME>.
It will display the document name on your document.

Time Type
These are only effective when you have checked the Date or Time.
Displays a list of additional options of forms of Stamps.

Date Type Select which forms you want to set of the Date stamp.

H.yy/mm/dd
This form is the Japanese description form using GENGOU
which means an era.
For example, at present, the "H.yy" is counted with an era of HEISEI.

Date Format 1~3"
These forms depend the Date & Time of Control Panels .

Time Type Select which forms you want to set of the Time stamp.

Time Format 1~3"
These forms depend the Date & Time of Control Panels .

Header (Footer) Style
If you wish to change the appearance of the characters of the Headers
(or the Footers), set the Font, Size, Style, Color, or the Justify.

3.6. Window Menu

Window commands control the situation of the document windows.

 Window

Tile

Stacl:
Maximize 7
Switch 38

Untitled1 #1
«Ointitled? %2

OiUntitled3 %3

Tile

Stack

Displays the windows so that all of them not be piled up.

When you execute it while holding the Shift key, it arranges the windows
vertically.

Displays the windows so that all of them be piled up.

This is equal to Cascade command of MS-Windows.
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Maximize Zooms the current window to fill the whole screen.
Switch Changes the current active window to the next window.
When you execute it while holding the Shift key, iText displays
the previous window.

Window Names  Displays a list of open iText documents.
When you select one, iText displays the document to the forefront,
makes it active.

When you upgrade to LightWayText or iTextPro ,
you will have more commands available including Show Toolbar and

Define Function bar

3.7. Help Menu

Help commands assist you.
You can quickly open the helpful documents, including the manuals, the sample documents,
and the sample stationaries in the iText folder. You can also check helpful information

online.

3 Information. htmil

O Text Manual E e
[ visitUs.html i b e T
(37 iTextPro Manual 3.1.6E 3

[ PAD File b

D) About Sample Document
. | [ Address/Sample
Light Way Information | [))-Manuscript/Sample
Purchase iTextPro Now... 0O Notepaper/ Sample
s — """‘. [ Scenario/Sample
[ Tables /Sample

(O Sample Stationary >
B el

Light Way Information Checks helpful information online.

Purchase iTextPro Now...
Checks 'Kagi Online Order Processing' website to purchase a license.

iText is Freeware. But, if you like iText and wish to make it more powerful,
you can change_your copy of iText to iTextPro with Key-registration ($15 per
user). If you are interested in iTextPro and would like to use it, please purchase
a license to make your registration.

Thank you very much for your friendly support.

When you purchase an iText Pro license ($15 per user), you will be licensed to
take advantage of iTextPro and iText Pro '08. If you have already purchased
either a license for LightWayText or iText Pro, you do NOT need to purchase a
new copy or pay an upgrade fee. Both your registration codes will still work with
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iTextPro and iText Pro '08.

ATo purchase your license;

1. Please select Purchase iTextPro Now... .
2. Type the number of copies you want to purchase into the 'iTextPro' box (or
‘LightWayText' box), on LightWayText/iTextPro Purchase page.

In most cases, you should just type '1".
If you want to have a registration code for all LightWayText Family
Applications, type the number of copies into the 'LightWayText' box.

We will be very grateful if you could feel iText is worth more than the registration
fee. You can up the number as bonus fee.

3. Then, click the Continue button and follow the '‘Kagi Online Order Processing'
instructions.

After you purchase a license, we will e-mail your registration code within 3 to
4 days. See 'Read Me (How to Register)' for more information.

4. Original Key Operations

We assigned the following as the Factory Settings .

Note: Option key is labelled alt on some Mac's keyboards.
Note besides, 'iText for Windows' binds
Control as Option , Alt as Command on a PC keyboard.

I%
e
When you upgrade to LightWayText or iTextPro ,

you will be able to change them and assign the special key operations for

the Menu commands, Control keys, Arrow keys and Function keys (F1~F12).

4.1. Menu Keys
Command +

Makes a new document window.

With the Open dialog, opens text documents.

Closes the document window.

Saves the contents of an open document.

Prints the document.

Quits the iText application and all open iText documents.

OTwsOZz

Reverses your last editing or formatting action.

Deletes the selection and puts it onto the Clipboard.

Sends the selection to the Clipboard.

Inserts a copy of the Clipboard at the insertion point or replaces the selection.
Selects all contents of the current document.

>< 0O XN

Displays the Find/Replace dialog.
Repeats the last Find or Find Selection commands, and searches for the
Next occurrence of the find.
Shift + G Executes the Find Next command backwards.
H Searches for the Next occurrence of the Find expression with the selection.

[OBa
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Shift + H Executes the Find Selection command backwards.

E Places the current highlighted selection in Find String as the Find expression.

= Changes the highlighted searched to the Replace expression.

R Executes the Replace command, and then executes the Find Next command.
Shift + R Executes the Replace command backwards.

M Displays the Mark dialog.

T Returns the selected characters to the standard.

B Sets the selected characters to Bold.

I Sets the selected characters to Italic.

U Sets the selected characters to Underline.

Y Displays the Document dialog.

/ Zooms the current window to fill the whole screen.

b Changes the current active window to the next window.
Shift + ° Displays the previous window.

1-9 Displays the selected document window at the forefront.

4.2. Control Keys
Control +

Moves the cursor to the 1 character left position.
Moves the cursor to the 1 character right position.
Moves the cursor to the 1 word left position.

Moves the cursor to the 1 word right position.
Moves the cursor to the 1 line upper position.
Moves the cursor to the 1 line down position.

Jumps the cursor to the 1 page upper position.
Jumps the cursor to the 1 page down position.
Jumps to the 1 line upper position.

Jumps to the 1 line down position.

Jumps the cursor to the head of the line.

Jumps the cursor to the end of the line.

Jumps the cursor to the top line.

Jumps the cursor to the bottom line.

Inserts a new Return code.

Inserts a new Tab code.

Deletes character to the left of the cursor position.
Deletes character to the right of the cursor position.
Deletes word to the left of the cursor position.
Deletes word to the right of the cursor position.
Deletes from the cursor position the start of the line.
Deletes from the cursor position to the end of the line.
Deletes the line with the cursor.

Replaces the text that was deleted. (It is same as Paste command.)

F<ACHAGCOI-ZOOOONSOIXMTM>ON
Onmowm

4.3. Arrow Keys

Option + Left Jumps the cursor to the word on the left.
Option + Right Jumps the cursor to the word on the right.
Command + Left Jumps the cursor to the start of the line.
Command + Right Jumps the cursor to the end of the line.

Option + Command + Left Jumps the page one character width to the left.
Option + Command + Right Jumps the page one character width to the right.
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Option + Up Jumps to the line above.

Option + Down Jumps to the line below.

Command + Up Jumps the cursor to the first of the page.
Command + Down Jumps the cursor to the last of the page.

Option + Command + Up

Jumps the cursor to the first line of the document.
Option + Command + Down  Jumps the cursor to the last line of the document.
Arrow + Shift Selects the characters.

4.4. Other Key Operations

Option+ Enter Inserts a Page Break (Page or Column Feed Code), and moves the cursor
to the start of the next page (or column).
SPACE Re-converts characters of the selected Japanese text. (Only in Japanese OS)
Shift + Delete Deletes the character to the right of the cursor.
Home Jumps the cursor to the start of the line.
End Jumps the cursor to the end of the line.
Option + Home  Jumps the cursor to the top line.
Option + End Jumps the cursor to the bottom line.

5. Before use of this software

iText is a "Freeware " program and the copyright of this software belongs to
"Michiaki Yamashita " who is the author.
Forbids any change to all of or any part of this software, without the permission of the author.

It does not guarantee that there will be no malfunction or errors in this software, and the author
is not responsible for any damage which arises from the use of this software.

Forbids distributing anything which adds a revision to file composition or contents of this
software. But, we encourage you to copy and distribute iText for non-commercial use

with the following restrictions.

You can copy and distribute the iText Package folder but not the individual

application and documentation files alone. This ensures that users receive a complete package
with all documentation, you may not modify the 'iText Package' folder in any way.

You may not charge any kind of fee for the use, copy, or distribution of this product.

s

If you find iText useful and wish to make it more powerful, you can change
your copy of iText to iTextPro with Key-registration.

Please reqgister and pay the Key Registration Fee ($15 per user) at
LightWayText/iTextPro Purchase page;

https://order.kagi.com/cgi-bin/rl.cqgi?R9X&&lang=en

iTextPro has more features than iText, and is almost same as LightWayText

except for the advanced features including Macro, Word Services, importing and

exporting Unicode format files (UTF8, UTF16), and Stream Editor.

Make sure iTextPro is only for Macs. (There is not any plan of iTextPro for Windows.)

You can also purchase LightWayText for a Shareware fee of $25 per user.
Both iText and iTextPro are compatible with LightWayText .
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When you need more features, please step-up to iTextPro or LightWayText .

The latest information about LightWayText and iTextPro can be downloaded
from the following sites;

LightWayText ; http://members.aol.com/LightWayText/

iTextPro ; http://members.aol.com/iTextPro/
2001.09.02
(Author): Michiaki Yamashita
(Zip code): 112-0012
(Address): 702, Otsuka 3-9-6, Bunkyo-ku, Tokyo, Japan
(Fax): (81) 3-3943-7621
(E-Mail): lightway@mac.com

KAEAAEXEAAXTAAXTAAXTAAXAAAXAAAXAIAAXAIAAXIAAXAIAXAXIAXAXAIAXAXAIAXAXAIAXAXAIAXAXAAXAXAAXAXAAKXAXKXAXKX
We wish LightWayText andiText makes all your heart bring this impression...

"If you have a Mac, use LightWayText or iText immediately.
It will become one of your favourite tools; your good friend eternally..."

We are fmproving i Text and Light Way Text

all the time, using your suggestions... f

E\ 7 o W

w Visitus  o®
Liglt Way Text;

bttpe! menbers. aol .com/Light Wiy Text/

If you have any questions, do not hesitate to contact Yumi (author of this manual)

directly at raphael@ya?.so-net.ne.jp.

I will certainly bring your suggestions to Mr. Yamashita, who writes the programs.

If you find iText/iTextPro and LightWayText as useful as we think you will,
please let your friends know about us !!
Thank you.

AEA A XA AT AAAAAAAAAAXTATAATAAAEATAATXAXTXTAAAAAAXAIAXAIAXTXAXAAAAXAIXAAIXTIAXAXAXAXAKXAAXAKXXAKXKXKX

6. Version History

Version 3.1.7E 2008.08.01
1. Starts releasing of " iText Express & iText Pro '8 for you to try.
2. Enhanced to comply with Mac OS 10.5.
3. Enabled to quickly open the helpful documents including the manuals and some sample
documents, and to check information online, from the Help menu.
4. Fixed some bugs and improved stability.

Version 3.1.6E 2005.05.11
1. Enhanced to comply with Mac OS 10.4.
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2. Supports EGBridgel5 's new feature 'Smart Inline Conversion' , so that the
performance of the Japanese characters' conversion under EGBridge is more efficient,
in response to Japanese user requests. (Only in Japanese OS X using EGBridgel5 as the
Japanese TSM-Inline method).
3. Fixed some bugs and improved stability.

Version 3.1.5E 2004.12.01
1. Changed iText into a real hybrid usable with both Mac and PC;
since 'LightWayText for Windows' and ‘'iText for Windows' are just being released.
If you often share documents between a Mac and a PC, put iText in both for convenience.
2. Increased the Font Sizes up to 5,000 points in response to user requests.
3. Enabled word movement with Option (or alt) + right or left Arrow keys.
4. Fixed some bugs and improved stability.

Version 3.1.4E 2004.06.11
1. Fixed some bugs in the Wordwrap , so that when Flow Lines is checked,
the 'smart quotes' are not separated from the text at a soft line break.
2. Fixed some bugs to improve stability.

Version 3.1.3E 2004.04.11
1. Enhanced iText-X to OS-X native application.
2. Support for a spell checker. (Only in OS-X)
3. Enabled the scroll to here feature. (Only in OS X).
4. Fixed some bugs to improve stability.

Version 3.1.2E 2003.12.21
1. Added a new item Words in the Document dialog of the Format menu, to show
the number of words.
2. Fixed some bugs to improve stability.

Version 3.1.1E 2003.11.11

1. Enhanced to comply with Mac OS 10.3.

2. Support for importing and exporting Rich Text Format (RTF) files.

3. Support for multilingual languages' Unicodes , including US-ASCII codes,
Japanese, European languages, Greek, Hebrew, Arabic, Turkish, and mathematical symbols.

(Only in OS-X)

4. Enhanced for longer file names (up to 255 characters) and some File commands' dialogs
for OS-X.

5. Added a new function Color Preference , so that you can set the default window color freely
except for built-in iMac's colors.

6. Enhanced Line Spacing tools in Format Tools, so that you can change the spaces sequentially
by keeping the Narrow and Expand buttons depressed.

Version 3.0.4E 2003.02.21
1. Improved some of names of the Menu items, dialogs, and the documents attached.
2. Added the new item of Start Page Number in order to set the title page.
3. Fixed some bugs on OS-X to make more stability.
4. Used 'CodeWarrior for Mac 8.1' and 'PowerPlant 2.2.1".

Version 3.0.2E 2002.03.21
1. Supported the Internet Config Extension (Command + Click email-address).
2. Coped with the Wheel Mouse (Microsoft Wheel Mouse Optical etc.).
3. Used 'CodeWarrior for Mac 7.2' and 'PowerPlant 2.2'".

Version 3.0.1E 2001.12.01
1. Added the Format Tools on the Ruler.
2. Added Form Tools menus to the Format menu.
3. Changed the key for Page Break to Option+Enter from Enter.
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4. Added Paragraph-formatting functions (Indents/Margins).
5. Coped with the Window-shade.
6. Included some examples files as what you can do with LightWayText .
7. Used 'CodeWarrior for Mac 7.0' and 'PowerPlant 2.2".

Version 2.2.1E 2000.12.11
1. Added Key Lime to the color variations.
2. Released "iText for OS-X".
3. Used 'CodeWarrior Pro6' and 'PowerPlant 2.1".

Version 2.1E 2000.07.21
1. Added Indigo , Ruby, Sage, Snow to the color variations.
2. Added the Function bar to the Preferences dialog.
3. Coped with the Internet Config Extension (Command + Click URL).
4. Improved the action of the cursor with the Home /End keys.

Version 2.0.2E 2000.03.15
1. Fixed the bugs with regard to the Vertical Writing, print and the scrolling.

Version 2.0.1E 2000.01.15
1. Added the Vertical Writing format function.
2. Coped with Contextual Menus. (with Control key + Click).
3. Used 'CodeWarrior Pro5.3' and 'PowerPlant 2.0'.

Version 1.2E 1999.02.11
1. Added new iMac's colors to the color variations.
2. Used 'CodeWarrior Pro4.1' and 'PowerPlant 1.9.3'.

Version 1.1.2E 1998.12.15
First release of the English version.

7. Introduction to the "LightWayText Family Applications”

' o

‘ 1

Thank you very much for trying this copy of iText !

We are also releasing LightWayText for Mac & Windows  (Shareware; $25 per user)
having many more features than iText.

We made iText to introduce LightWayText to more people around the world.
LightwayText is a hybrid, reliable, and powerful Text Editor with multilingual word
processing and is completely compatible with iText.

We have changed the idea of a "Writer's Workshop' into a reality.

With LightWayText , you have high stability and all the power you expect from a full-featured
word processing program.

You will find "LightWayText & iText" follow those other easy to use Apple favourites!!
Please try LightWayText too! For further details, see'ReadMe (News!)' in separate file.
LightWayText French for Mac, LightWayText Italian for Mac are on release too!
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LiqhtWavText & iText are usable with both Macs and PC !

LightwayText is a Hybrid-shareware which can be used with both a Mac and a PC.

It gives you almost the same operating environment on both computers as well, and it is
compatible with each other's documents.

‘LightWayText for Windows' and 'iText for Windows' cover Windows 95 and
later versions including Windows-XP.

If you often use a Mac and a PC, for convenience install LightWayText and iText in both.

Just one LightWayText license will cover both versions.

An English language version of LightWayText & iText for Windows  are now on release !
A French and an lItalian languages' versions of LightWayText for Windows are on its way,
and will be available soon !

LightWayText is Shareware . If you are interested in LightWayText and intend to use it
continually, please register and pay the Shareware Fee ($25 per user).

When you register LightWayText, you will be licensed to take advantage of all languages'
LightWayText in both Macs/PC and 'LightWayText Family Applications (iText/iTextPro,
iText Express/iText Pro '08)'.

The license will include all languages’, and all future versions for both Mac and PC.

Note: If you need more information about LightWayText and iText,
please email us at raphael@ya?2.so-net.ne.jp.
We will be more than happy to provide you some more improved versions
and information from time to timel!

ﬂ.- Anyway, try LightWayText outonce ! -&'

You will find it is well worth the Shareware cost !!

When you register LightWayText , you will be licensed for both the Mac and PC
versions of LightWayText and the LightWayText Family Applications, including all
future versions. If you have already registered a previous version of LightWayText,
you do NOT need to purchase a new copy or pay an upgrade fee.

You can also upgrade_your copy of iText to iTextPro with Key Registration ($15 per user).
iTextPro is almost the same as LightWayText except for the advanced features

including Macro, Word Services, and Stream Editor, but it is only for Macs.

(There is not any plan of iTextPro for Windows.)

ﬂ.- We are now gifting ‘iTextPro Trial Key' to applicants! -..!:.-

Why not share iText with your friends ?
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We think it would be great if many of you were interested in iText and LightWayText .
If you find iText as useful as we think you will, please let your friends know about us !!

If you would care to share iTextPro with your friends, please send us an email
with your email address and that of your friends, to raphael@ya2.so-net.ne.jp.

We will send an 'iTextPro Trial Key (effective for 30 days)’ to both you and your friends !
Note that, 'iTextPro Trial Key'is NOT available for iText Pro '08.

Jo Fo Jo o% % %

When you need more features, please step-up to iTextPro or LightWayText !!

LightWayText/iTextPro Purchase page at;
https://order.kagi.com/cgi-bin/rl.cqgi?R9X&&lang=en

*Ei" The latest LightWayText & iText can be downloaded from the following sites;

L ightWayText Website; http://members.aol.com/LightWayText/

- LightwayText for Mac ;

http://members.aol.com/LightWayText/pad_file.htm
- LightwayText for Windows ;

http://members.aol.com/LightWayText/L WTWin/pad_file.htm
- Version Francaise ;
http://members.aol.com/LightWayText/L WTfr/pad_file.htm

- Versione ltaliana ;
http://members.aol.com/LightWayText/LWTit/pad_file.htm

iText; http://members.aol.com/iText/
iTextPro ; http://members.aol.com/iTextPro/

i ext Express & i Text Pro '08;
http://members.aol.com/iText/iTextExpress/TryiTxtExp.html

Jo Fo Jo ok % &%

E
&% Dear friends ! .0 ®

Let me tell you another good news for you!
We have just released 'i Text Express' and 'i Text Pro '08' !

'i Text Express & Pro '08' exploit OS X to the full, as they're completely
rewritten in Cocoa!
They will blend more seamlessly with the OS X environment,
and we are convinced you will definitely love 'iText Express & Pro '08'
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and it will continue to grow with the power of Mac OS X.

'IText Express & Pro '08' are a Universal Binary.

iText Express & Pro '08 require OS X 10.3 onwards , including OS X 10.5
and are suitable for both Power PC and Intel Macs .

We think it would be great if many of you were interested in iText and LightWayText .

If you find iText as useful as we think you will, please let your friends know about us !!

Thank you!

Macintosh products
LightWayText, iText/iTextPro, iText Express & Pro '08 for Macs

All these products are L eopard Compatible!!

e LightWayText (Shareware) Covers Mac-OS 7.1 onwards, including OS-X (10.5).
— LightWayText Ver.4.1.7 for Mac / Japanese Version (December 01, 2007)
— LightWayText Ver.4.1.7 for Mac / English Version (August 01, 2008)
— LightWayText Ver.4.1.7 for Mac / French Version (August 01, 2008)
— LightWayText Ver.4.1.7 for Mac / Italian Version (August 01, 2008)
e iText (Freeware) Covers Mac-OS 7.1 onwards, including OS-X (10.5).
—iText Ver.3.1.7 for Mac / Japanese Version (December 01, 2007)
& iText Pro Ver.3.1.7 for Mac / J (December 01, 2007)
— iText Ver.3.1.7 for Mac / English Version (August 01, 2008)
& iText Pro Ver.3.1.7 for Mac /E (August 01, 2008)

Note that iTextPro is only for Macs. (There is not any plan of iTextPro for Windows.)
LightWayText andiText keep going!!

e iText Express (Freeware) Covers OS X 10.3 onwards, including OS X 10.5 (Leopard).
Thoroughly compatible with TextEdit as well as Leopard !

— iText Express Ver.3.1 for Mac / Japanese Version (June 15, 2008)
— iText Express Ver.3.1 for Mac / English Version (August 01, 2008)

e iText Pro '08 (Shareware) Covers OS X 10.3 onwards, including OS X 10.5 (Leopard).
Thoroughly compatible with TextEdit as well as Leopard !

— iText Pro '08 Ver.3.1 for Mac / Japanese Version (June 15, 2008)
— iText Pro '08 Ver.3.1 for Mac / English Version (August 01, 2008)
Windows products LightwayText, iText for Windows
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= LightWayText (Shareware) Covers Windows 95 and later versions, including Windows XP.

— LightWayText Ver.4.1.6 for Windows / Japanese Version (March 21, 2005)
— LightWayText Ver.4.1.6 for Windows / English Version (May 01, 2005)

e iText (Freeware) Covers Windows 95 and later versions, including Windows XP.

— iText Ver.3.1.6 for Windows / Japanese Version (March 21, 2005)
— iText Ver.3.1.6 for Windows / English Version (May 11, 2005)

A French and an Italian languages' versions of LightWayText & iText for Windows are
being considered, and will be available soon !

In closing,

Thank you very much for trying iText and reading this document.

Please let me express my maximum gratitude to you. Also again, please accept my apologies
for deficiencies in my English which is far from perfect.

I hope this will cause you laughter and not anger...

Many people have encouraged us and contributed to the development of iText and
LightWayText in variety of ways. In a sense, | can say that iText-E is a crystal which is
trying to overcome the barrier of languages little by little... | feel this strongly and |
sincerely appreciate that it is nice to know that there are friendly and helpful people all
around the world...

I would like to express special gratitude to the following individuals for their assistance:
Paul & Rita Pease, Michel Robert, H.P.G. Kouwenhoven, Simon Beaudry, David Sobotta, Jules
Allen, Jurij Gianluca Ricotti, CharleswW.Moore, Frédéric Blaison, Jennifer Berger, Sharon L.
Cordesse, Tim Woodruff, Kris Fong, Kyle Williamson, Henri Guerard, Gerard Lasseur,
Fabrizio Venerandi, Philip David Morgan, Jean Salou, Yves-Marie Maurin, Prof. Dr. Manfred
Kropp, Nan Goldberg, Gene van Troyer, Neil Van Ess IV, Donald Stanat, Joan D.Brader, Louis
ROUSSEAU, BjornBerke, JasonSunja Goldenrose, Larry Gibson, Stefan Fischer, Marianne
Jones, David Langer, Robert U. Guthrie, Larry J Bouten, Hermann Hildbrand, Hans-Harald
Herrmann, Rick Curran, Carlo Moll-Dillier, Ingrid Klock, Matteo Colombo, Ramona R.
Baumann, Daniel Carolin, Richard G. Whitten, Robert van Vaals, Sue Whitehead, Doug
Lerner, Spiros Diolitsis, Guilherme Silva, Bill Muench, Geoffrey Thomlinson and Prof. Dr.
Eric Jauteek.

In particular, please let me express my special thanks to my dearest teacher Doug Browne -
an encounter with you is an unforgettable occasion in my life...

Without you the achievement of iText 3.1.7 could not be possible...

If you have any questions or cause for complaint, please do not hesitate to let me know

at raphael@ya?2.so-net.ne.jp. We will be most grateful for your comments, and | will
certainly bring your suggestions to Mr. Yamashita. Or, if you there is any information you
require, please contact me directly !

We hope you find LightWayText as useful as we think you will... We intend to include your
suggestions in the future... Please let your friends know about us !!

Cordially, thanks for your kindness...
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- by author of our documents & web pages, Yumi “¥g

LightWayText 4.1.7, iText/iTextPro 3.1.7, and iText Express & iText Pro '08 3.1
©1996-2008 Michiaki Yamashita, All rights reserved.
Used PowerPlant2.2. © Metrowerks Inc.
LightWayText, iText, and iTextPro are registered trademark of Michiaki Yamashita .
Finder, Macintosh, MS-Windows, SimpleText, MacWrite are trademarks or registered
trademarks of the respective product's manufacturer.
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